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The LabVIEW Engine behind ROBOLAB
What does powered by LabVIEW mean? LabVIEW is a powerful programming

environment used by engineers and scientists to help with tasks like manufacturing, quality
testing and data acquisition.  It is a graphical software development tool that allows them to
create powerful software applications that assist them in their research or work.  During
NASA’s 1997 Mars Mission, LabVIEW was used to monitor the Sojourner Rover’s position and
status during its exploration of the planet’s surface.
 While the power and complexity of LabVIEW is essential for NASA level projects and
scientists, children and LEGO components demand less power and a less complicated interface.
To fill this need, a special edition of LabVIEW was created to power ROBOLAB. It has fewer
options and a user interface that is easy to use .

In the Inventor Level of ROBOLAB there are some core LabVIEW functions that appear.
These features, which are not described in the ROBOLAB documentation, are available due to
the fact that ROBOLAB is powered by LabVIEW.  It is not necessary to use these functions in
order to program effectively with ROBOLAB but some of these features can be helpful in
programming.  However, many of the functions are LabVIEW specific and  do not serve any
purpose in the ROBOLAB /RCX set-up.  These functions  are designated with a (*) number sign.
If you are interested in advanced programming, it is recommended that you obtain a LabVIEW
guide.

The Inventor level programming has two windows that are open.  One is the Panel Window, and
the other is the Diagram Window.

Panel Window

The Panel Window is not used in
the Inventor programming, but must
be open for Inventor to run.

Diagram Window

Programs are created in the
Diagram Window.
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The Panel and Diagram windows have identical menu bars.  The functions associated with each
item will be explained, as well as some other features and capabilities available in the Inventor
level programming.

Menu Bar

File Menu
The File Menu gives you options for accessing and saving files,
printing options, and exiting from the program.

New – Selecting New opens two new windows for a new program on
top of existing  Panel and Diagram Windows.  The new windows
have exactly the same icons and information as the two windows that
they are covering.

Open – Selecting Open brings up a window
that you can use to browse through the
computer to find the file you would like to
open.

Close – Selecting Close will close the
Inventor program that is showing.  If there
is only one Inventor program open, Close
returns you to the Main Programming Menu Screen.

Save – Selecting Save will save your file with its current name to its original location.  If you
have not previously saved it, the Save As option automatically opens.

Save As – Selecting Save As brings up a window that you can use to select where you would
like to save the file, and what name you would like the file to have. Files saved places outside the
suggested location may not be visible from the Main Menu.

In addition, there is a button called New VI Library that allows you to create a new
VI Library in which to store the file.

What is a VI Library?  VI Libraries have the same load, save, and open capabilities as
folders and directories.  However, your operating system sees them as
single files.  You can access their contents only from LabVIEW.  VI
Libraries contain only compressed versions of VIs.  In file dialog boxes, a
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VI Library appears as a folder or directory icon with an extension of .llb
appended to the name.1

VI Libraries will not appear in the ROBOLAB main menu. They can be
accessed from the File Menu in Inventor.

Printer Setup – Selecting Printer Setup brings up a window from which you can select the
printer, how many copies you would like, and how it is setup.

Print Window -  Selecting Print Window from the Diagram Window will print
•  the name of the file,
•  the location of the file on the computer,
•  the date the file was last modified,
•  the time it was printed,
•  an image of the program.
This is the typical method for documenting and printing your ROBOLAB programs.
Selecting Print Window from the Panel Window will print the same information but instead of
an image of the program, an image of the Panel Window will be printed.

Exit – Selecting Exit brings up a window with the option of Back or Quit.  Selecting Back takes
you to the Introductory Screen.  Selecting Quit will quit ROBOLAB.

Edit Menu
The Edit menu selection gives options for ways to edit the
program or items in the Diagram and Panel windows.

Undo – Selecting Undo will undo the last thing that was done.
It recognizes if items were moved, deleted,  or inserted.

Redo – Selecting Redo will redo the last thing that you undid
with the Undo option.

Cut – Selecting Cut will delete whatever item(s) are selected and keep a copy on the clipboard.

Copy – Selecting Copy will copy whatever item(s) are selected to the clipboard.

Paste – Selecting Paste will insert the item(s) from the clipboard to the window.

Clear – Selecting Clear will delete the item(s) that are selected.

                                                          
1 Excerpt from LabVIEW Student Edition User’s Guide,  by Lisa Wells, 1995
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Remove Bad Wires – Selecting Remove Bad Wires will delete all the incorrectly attached
strings in the program on the Diagram window.  These wires are denoted on screen by dashed
black and white lines.  They can also be removed by using the keyboard shortcuts CTRL-B (PC)
or CMD-B (MAC).

Operate Menu
The Operate option has to do with the downloading or aborting of
downloading of the ROBOLAB Inventor Level program.

Run – Selecting Run is one of the ways to download the program that is in the Diagram window
to the RCX. Choosing the Run option is equivalent to pressing the Run button on the left of the
menu bar. If your program has errors or is incomplete, selecting run will bring up the list of
problems that your program has (See Broken Run under Menu Icons for further detail)

Stop – Selecting Stop will terminate the download of the program to the RCX.

Project Menu
The Project option is a shortcut way to change some of the
working conditions of the programming.

Change Inventor Level – Selecting Change Inventor Level brings up a window with the four
Inventor Levels.  Choosing the one you would like to work with will then open the functions that
are available in that level.

Select COM Port – Selecting Select COM Port brings up a window with the options of  which
COM Port the IR Transmitter is currently attached or Text.  Text is used to see the written
program logic on the computer screen.

Window Menu
The Window Menu has all the options that control the
various windows that can be open.  The options on this
menu depend on which window you are currently
working in (Panel or Diagram)

Show Panel – Selecting Show Panel makes the Panel
window visible and your active working window.
(Available only from Diagram Window)

Show Diagram – Selecting Show Diagram makes the
Diagram window visible and your active working window.  (Available only from Panel
Window.)
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Show Functions Palette – Selecting Show Functions Palette opens the window with the
Command Menu Icons in it.

Show Controls Palette – Selecting Show Controls Palette opens the window with the
controls palette.  This is only an option if the Panel is active instead of the Diagram.

Show Tools Palette – Selecting Tools Palette opens the window with the various tools
that can be used in LabVIEW and ROBOLAB programming. The
ROBOLAB names, where applicable,  appear in ( ).

What are the items in the Tools Palette used for?

Operate Value (Placement):  Selecting this tool allows you to
change values that can be displayed on the Panel window.

Position/Size/Select (Select Tool):  Selecting this tool allows you to click on an
icon and select it.  Once it has been selected, clicking and dragging it will move it

to another location.

Edit Text (Text Tool):  Selecting this tool allows you to insert or edit text boxes in
the Panel or Diagram Windows.  Click to place the start of the text location, and

type the content.  If you want to modify existing text, click and drag the tool across the
text to highlight it and then type in the new text.  Edit Text is useful to create labels for
programs.

Connect Wire (String Tool):  Selecting this tool allows you to string the icons
together.
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Object Popup: Selecting this tool provides easy access to modifying settings for
items in the Panel or Diagram window.  The same option is achieve by right clicking

on the item (PC) or Command clicking on the item (MAC).  The Object Popup setting
options are:

Description:  Selecting Description brings up a window with a
description of the item selected.

Show:  Selecting Show allows you to show or hide the item label and
string connection locations.

Replace:  Selecting Replace is THE MOST USEFUL option.  It opens
the Function window and allows you to select a new icon to replace the
current one, without having to go through the process of deleting,
placing a new one, and then stringing it into the sequence.

Cluster Tools*:  Selecting Cluster Tools allows you to combine or
break apart the information in bundles of strings.  Clusters are used in
ROBOLAB to pass information from command to command. This is
used in advanced level programming.

Array Tools*:  Selecting Array Tools allows you to manipulate data
that is contained in the strings. The RCX cannot make use of the arrays
so this is used in advanced level LabVIEW programming.

Create Constant*:  Selecting Create Constant generates a constant
value at the specified location. This is used in advanced level
programming.

Create Control*:  Selecting Create Control generates a control item at
the specified location in the program. This is used in advanced level
programming.

Create Indicator*:  Selecting Create Indicator generates an indicator
item at the specified location in the program. This is used in advanced
level programming.

Open Front Panel:  Selecting Open Front Panel displays the Panel
Window and makes it the active window.

                                                          
* LabVIEW feature with no functional use on ROBOLAB
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Scroll Window:  Selecting this tool allows you to click on the Panel or Diagram
window and move it within the open window space.

Set/Clear Breakpoint*:  Selecting this tool allows you to put a suspension in the
execution of your program.  This is used in advanced level programming.

Probe Data*:  Selecting this tool allows you to probe the program for values along
the string.  This is used in advanced level programming.

Get Color:  Selecting this tool allows you to copy a color from an image in order to
use it as part of the color palette.  This is used in advanced level programming.

Set Color:  Selecting this tool allows you to set colors of objects in the
Panel and Diagram windows.  This is used in advanced level programming.

Show Clipboard – Selecting Show Clipboard opens a window that shows the current contents of
the image or text in memory.

Show Error List – Selecting Show Error List brings up the LabVIEW error window with the
programming errors for the program in the Diagram window.

Full Size – Selecting Full Size from the Diagram Window Menu will make the Diagram window
fill the screen.  Selecting Full Size from the Panel Window will make the  Panel window fill the
computer screen.

ROBOLAB filename.vi – Selecting ROBOLAB filename.vi brings the Panel window of the
program filename to the front as the active ROBOLAB program and window.

ROBOLAB filename.vi Diagram – Selecting ROBOLAB filename.vi Diagram brings the
Diagram window of the program filename to the front as the active ROBOLAB program and
window.

Help
The Show Help option is used to view on screen help for the
Inventor Level programming.

Show Help – Selecting Show Help opens the help window.  If
the help window is open, selecting Show Help will close the
Help window.

                                                          
* LabVIEW feature with no functional use on ROBOLAB
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Lock Help – Selecting Lock Help keeps the information displayed in the help window from
changing as you move the cursor around the screen.

About ROBOLAB – Selecting About ROBOLAB brings up a window that gives you a little bit
of information about all the cool places that helped in the development of ROBOLAB.

Menu Icons

Run
The Run button can be used to begin the download of the Inventor program to the
RCX via the IR Transmitter. Clicking on this button is equivalent to opening the

Operate Menu and selecting Run.

Broken Run When the run button appears as a broken
arrow that means that your program is
incomplete or has an error. Clicking on the

broken run button will bring up a list of problems with
your program.  Clicking once on the error and then on
the Find button will highlight the problem area or icon
in your program

Abort Run
The Abort Run button can be used to end the download of the Inventor program from
the computer to the RCX. Clicking on this button is equivalent to opening the

       Operate Menu and selecting STOP.

Text Settings
The Text Settings is a drop down menu that allows you to modify
the size, style, color, and font of text in text boxes.
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The text can be changed in the Panel or Diagram by highlighting it with the text tool and the
selecting settings from the Text Setting drop down menu.  Text changes are saved with users
programs and do not alter the original templates for the Inventor Level Programs.

Align The Align icon allows you to easily align selected icons in one of
six pre-set formats.

Before Top Edge Alignment After Top Edge Alignment

Distribute
The Distribute icon allows you to
easily distribute icons in one of ten
pre-set formats.

Before Horizontal Gap Distribute After Horizontal Gap Distribute

Reorder*

The Reorder icon allows you to change the order that
items are ‘layered’ in your Panel or Diagram
windows.  Layering only occurs in some very
advanced programming situations.

                                                          
* LabVIEW feature with no functional use on ROBOLAB
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The icon associated with your program can be modified with an image of your choosing.  To do
this, right click on the icon image on the right end of the menu bar(PC) or command clock on the
right end of the menu bar (MAC).  Selecting the edit icon option will bring up a window that
allows you to create your own icon image that will be saved with your program. You have the
option of a Black and White icon, or an icon based on 16 or 256 colors.  Selecting which type
you would like, and then working with the drawing and text options shown on the left side of the
window will allow you to create the new icon image.

Exiting Inventor

Upon exiting inventor the “Save Changes” dialogue
Box appears.  If you have made changes to a
program that you would like to keep choose “Yes.”
To exit Inventor without saving the changes select
“No.”  If you wish to see what changes were made
select “Explain.” If you do not wish to exit Inventor
select “Cancel” and you will be returned to
programming. Any changes you make will be
saved to a new file and will not alter the original
template for an Inventor Level in anyway.
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